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Chapter 1

Preface

KCS Monitor, also known as “TCMON” is a lightweight maintenance application for the Kofax
Communication Server. It displays the status of the services and some additional module dependent
information of the server.

For message servers, TCMON displays the status of all channels, nodes and disks.

Additionally, it allows to start and stop the supervisor service of a TCOSS server, to start and stop every
single process of a TCOSS server and even to restart an entire PC.

For message servers, TCMON allows to reboot nodes, to reload a channel’s configuration or to clear the
status of a disk in order to resynchronize a tandem system.

This application supports Windows Server 2008 – 2012.

To start or stop the service or to restart a PC using this application you have to have administrator
privileges at the server.

To start or stop a process a special password is required if security check is enabled at the server.

To display and maintain a message server any valid TCOSS user ID and password is allowed.
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Menus and buttons displayed may be disabled because they are not implemented yet.

Important The Kofax Communication Server and its components formerly used the name
TOPCALL. Some screen shots and texts in this manual may still use the former name.

Unicode Support
KCS Monitor can display Unicode characters if you configure a suitable font (such as Arial Unicode MS),
however, you cannot log in as a user with Unicode characters.

Display
The display shows the list of servers with the corresponding tree of services, channels, nodes and disks.

In order to view and maintain a server with TCMON, it must first be added to list of servers displayed.

Two types of servers are possible. The generic server may be any TCOSS model. TCMON displays
the state of the supervisor service, the status of all processes it controls and eventually some additional
information for the processes.
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An active supervisor service is represented by a computer icon ( ). The icon has a grey color ( ) if
there is a supervisor service configured, but it is not started. The icon triangle turns into dark blue with a
red exclamation mark if any connection problem, such as an invalid password, occurs.

The text on the right hand side of the image is the Windows network name (or the TCP/IP address) of the
server including a short state description.

Processes controlled by the supervisor service are displayed as traffic lights. A green traffic light indicates
a running process. The text beside the image is the unique process name including a short status
description. The decimal number in parentheses represents the status value. A value of 0 always means
OK. A value from and above 2000 is a fatal error and causes the process to be restarted.

The status text and values depend on the process. They are not necessarily the same between different
processes and may change between different versions.

Every process may have multiple balloons. Balloons below the process may contain some informational
text.

Note This text is process specific. It is not necessarily related to the current status of the process. It may
be written at any earlier time and outdated at the moment you see it.

The status of the server and its processes is updated automatically every few seconds. Delays in updating
the status may be caused by connection problems to the server.

When the supervisor service or the entire server is stopped, only the server’s state is updated. The status
displayed for the processes is the last one read before the connection was lost.

The second type of server in the server list is the Model 125/145/155/165/21x/22x message server
(TCOSS). TCMON displays the status of all channels, nodes and disks of the message server.

An active message server is represented by an envelope icon ( ). The icon is grey ( ) if no connection
can be established to the server. The text on the right hand side of the icon is the server ID (as with TCfW)
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and a short status description. A short extension “(Msg)” to the server ID allows distinguishing between
message servers and generic servers with the same name.

Below the server, all configured channels are listed. Channels have different icons to indicate the type and
state. A detailed description can be found later in this manual.

The descriptive text for each channel consists of the channel number including a colon and the description
configured within TCOSS. There is no text describing the status of the channel.

After the list of channels, TCMON displays the tree of the message server’s nodes. The text describing
the node consists of the node number including a colon, the type of the node (the hardware or interface)
and – in some cases – a short status description.

Node 1 is the root node, which represents the (Primary) Master. The root node always has a hard disk
connected to it. The status text of the disk consists of the disk number including a colon and short status
description.

If it exists, Node 2 is always the Secondary Master of a fault tolerant Model 165/22x. Usually this node
contains an additional hard disk to mirror all data.

The images displayed for nodes and disks change depending on the status.

The status of the server and its processes is updated automatically every few seconds. Delays in updating
the status may be caused by connection problems to the server.

When the message server (TCOSS) is stopped, only the server’s state is updated. The status displayed
for the channels and nodes is the last one read before the connection was lost.

Menus and Commands
The overview of the menu commands is divided between configuration and control commands

Context Menu
Each function based on server (except message server) or processes can now also be accessed by
context menus. The context menu will at least contain the possibility to start or stop the currently selected
application. Context menus take care of the availability of the new configuration features for the selected
node types.
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Of course all actions are also available in the menu of the KCS Monitor (see below.)

Control Functions
Control Functions of TCMON can be executed using Menu Commands, Toolbar Buttons, Context menu or
Command Line Options.

The Toolbar contains most of the commands from the menus, to speed up common tasks such as adding
or removing servers from the list.

The Toolbar is detachable and can be placed elsewhere on the desktop.

The buttons on the toolbar are grouped into categories of commands with similar meaning. The leftmost
group of buttons allows adding and removing servers.

The corresponding commands can be found in the File menu.
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The File menu additionally contains a list of most recently used servers in order to quickly add servers that
have already been used in the past.

When starting TCMON, a list of servers can be specified at the command line. All servers are
automatically added.

These four buttons to allow starting, stopping processes and reloading configurations belong to the group
of basic monitoring functions. 

The corresponding menu options can be found in the Tools menu.

These buttons to allow starting and stopping the supervisor service belong to the group of enhanced
server control.

The corresponding menu options can be found in the Tools menu.
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Following buttons allow to reset or reboot an entire server (the entire PC) or a certain message server
item.

The corresponding commands can be found in the Tools menu.

The command to reboot the entire server belongs to the group enhanced server control.

All other commands to reset a message server’s item belong to the group message server monitoring.

Configuration Functions
Configuration functions are used to configure the currently selected node. All these commands are only
available if the configuration mode is enabled and a KCS Monitor Add-on exists for the currently selected
process.

Copy the selected node to the clipboard.

Pastes the content of the clipboard at the insertion point. The KCS Monitor Add-on responsible for the
pasting displays a “wizard” to ask the user about the mandatory changes.

Delete removes the selected node without placing it to clipboard.

This command is only available for configurable nodes.
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Note This command deletes “only” the local settings (registry keys, configuration files entries etc.);
neither the files nor the KCS or Mail dependencies are removed.

This menu entry allows changing the configuration of the nodes via an installed KCS Monitor Add-on. All
configuration changes are made permanently only after the user actively accepts them. This prevents
unwanted changes.

KCS Monitor Add-ons
Users can more easily configure a server’s local processes with KCS Monitor Add-ons. An Add-on
provides a simple user interface specific to a certain type of process. This user interface allows entering or
changing all configuration parameters without knowing about any internal registry structures.

In addition, Add-ons allow deleting or copying entire processes at the server.
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Display Elements

This section describes the display elements.

Servers
Servers are the root items within the tree view displayed. The two types of servers can be distinguished
by the color of their icon in the active/connected state and by the “(Msg)” extension of the message server
name. It is allowed to add one message server and one generic KCS server with the same name.

Status changes for servers are always real-time, i.e. the status displayed can be considered the current
status of the server (with more or less delays for poll cycles and connect times).

Server icons:

 Computer
icon

Indicates an active supervisor service and TCMON can successfully connect to it. 
The status text contains “server active” in this case.

 Gray
computer icon

Displayed when TCMON cannot connect to a computer. Appears permanently if the specified protocol type
does not match the type configured with the supervisor service. Also appears if the password for logging
on is not correct. May appear a short time when the service starts, or if multiple instances of TCMON try to
access the same server at the same time. 
The status text contains the system error code.

Message server icons:

 Envelope
icon

Indicates an active message server (TCOSS) and TCMON can successfully connect to it. The status text
contains “connected” in this case.

 Envelope
icon with red
exclamation
mark

Displayed on any connection error reported by the message server (e.g. invalid password).
The status text contains the TCSI error code and a descriptive string for common error codes.

 Gray
envelope icon

Displayed when connection to the message server cannot be established. The error text says “server busy
or switched off”.

Processes
Processes are always one hierarchy level below the generic KCS server. The processes displayed as
sub-items of a server are controlled by the supervisor service of this specific server.
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The status displayed for processes is real-time as long as there is a proper connection to the server. If the
connection fails, the last properly read status is kept.

 
Green Traffic
Light

Process is running. 
The status text contains the name of the process plus any text and status code (in parentheses)
generated by the process.

 
Yellow Traffic
Light

Process is about to be started or stopped.

The status text contains the name of the process plus the description of the intermediate status.
The Status can be “starting”, “stopping”, “waiting for ..” and more.

 
Red Traffic
Light

Process is stopped.
The status text contains the name of the process plus the word “stopped”.

Process Information
Any process may have some informational text as sub-items. This informational text is completely process
specific. In this document no assumptions can be made about the relevance of this information.

 Info balloon One line of additional process specific information.

Channels
Channels appear as sub-items of message servers only. The first hierarchy below the server represents
the collection of channels. This hierarchy level is for clarity and just acts as container for the actual
TCOSS channels.

The channels do not display their status as text. The status can be seen by the specific icon for a channel.
The text displayed for a channel is the channel number and the description configured for that channel
within TCOSS.

 
Two blue arrows

Represents the channels collection. Has no status.

 
Two white arrows

Active Channel. Set to continuous operation.
The channel is idle.

 
Blue and white arrows

Active Channel. Set to continuous operation.
The channel is sending

 
Blue and green arrows

Active Channel. Set to continuous operation.
The channel is sending and backreceiving.

 
White and blue arrows

Active Channel. Set to continuous operation.

The channel is receiving.
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Two red arrows

Active Channel.

Line error occurred (can be caused by disconnecting the FAX or TELEX line)

 
Two white arrows with Q
character

Active Channel. Set to query operation.
The image does not change on sent or received messages.

 
Two white arrows prohibited

Active Channel. Set to pause.
Sending is disabled but receiving is possible.
The image does not change on received messages.

 
PC with globe

Active Client/Server Channel.
The image does not change.

 
Two white arrows
with exclamation mark

Reloading Channel Configuration. 
This status appears when the channel is forced to reload its configuration. This can be done
using the corresponding menu or button from TCMON, or using the corresponding dot-dot-
command with the console.

 
Two gray arrows

Inactive Channel.
The channel is not started. This happens to channels located on nodes not booted.

Nodes
TCOSS is a distributed system and may run in multiple fragments on different parts of the hardware. A
node is a part of the hardware with a certain fragment of TCOSS running on it. Most types of nodes can
have sub-nodes.

Node 1 and node 2 represent the primary and secondary master of a TCOSS system. These two nodes
additionally have a hard disk connected.

The tree of nodes always starts with node 1. This is a direct sub-item of the message server in the tree
view.

The status text for any node is the node number including a colon and the type of node. The type of
node usually indicates the hardware the node is based on. The hardware may be for instance TSNT for
Windows based nodes, TS33 or TC20 for the corresponding FAX interfaces.

The status text may contain an additional description of the current status.

 
Red triangle connected to
two blue triangles

Represents the root node in the tree view. This is always node 1. 
The status text contains “root node”.

 
Three blue triangles

Represents any active sub node in the tree. The node is booted entirely and running properly in
this state. All channels are started.
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Exclamation mark over gray
triangles

Represents a node manually reset by TCMON or the corresponding dot-dot-command.

In this state, the system is waiting for all channels at the specific node to finish the current task
before the hardware is reset and the code stops executing.

The status text contains “waiting”.

 
Gray triangles

In this state, the node is not booted. This happens after any kind of hardware reset until the
node’s operating system is loaded and started.
The status text contains “not booted”.

 
Dark gray triangles

The operating system has been successfully started on the node and the channels are being
started.
The status text contains “booted”.

 
Blue triangles prohibited

The node was stopped because of locally detected errors. Any kind of problem occurred after
the node started its operating system and before it finished starting the channels. The node
enters this state after some retries. It can be caused by a hardware problem.
The status text contains “stopped”.

Disks
Disks are always sub-items of nodes number 1 and 2. With non-tandem systems there is no node 2 and,
therefore, only one disk at the root node 1.

The status text is the disk number including a colon and additional strings describing the status of the disk.
Possible strings are:

“Not OK”, “OK” The accessibility of the disk. On “Not OK”, the disk is marked as defective and cannot be used by
TCOSS. This not necessarily a hardware defect. TCOSS may temporarily set the disk to “Not OK” to
prevent from accidentally booting with invalid hard disk data.

“Not Mirrored” The data of the disk has no backup by a second disk. For a tandem system, this means the second hard
disk is not available or its data is not up to date. For single hard disk system, this is always the case. In
addition to this status string, the date and time is displayed when the mirror was broken.

“Updating” The current hard disk’s data is outdated and is resynchronized with the other hard disk. This happens
automatically after booting the system or rebooting one master of a tandem system. If both hard disks
are “Not Mirrored” (De-synchronized), the system cannot determine the hard disk with the most recent
data automatically. In this case “Updating” can be forced manually for one disk using the corresponding
TCMON button or menu command.

 
Hard disk

Active not mirrored hard disk. The disk is actively used by TCOSS but has no backup by a second disk.

 
Double hard disk

Active mirrored hard disk. The disk is actively used by TCOSS and is backed up by a second disk.

 
Double HD with
red exclamation
mark

Active disk being updated. The disk’s data is outdated and is being resynchronized.
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Hard disk
prohibited

Defective disk. The disk is defective because of a hardware problem or temporarily set defective by
TCOSS.

17



Chapter 3

Security

To prevent from unauthorized access to a server, it is necessary to be logged on to a server in order to
monitor the server.

There are three distinct groups of functions to monitor and control a server.
• Enhanced Server Control
• Message Server Monitoring
• Basic Monitoring

Each of them uses a different authentication mechanism.

Enhanced Server Control authentication is performed by standard Windows login mechanisms at the
server.

Message Server Monitoring authentication is performed by the message server (TCOSS).

Basic Monitoring authentication is performed by the supervisor service (TCSRV).

Enhanced Server Control
This group of functions is used to control the supervisor service or the operating system Windows itself.
It is intended for use by Kofax staff in case of release updates or other maintenance work locally at the
server. The menu options within this group are Start/Stop Service and Restart Server.

The enhanced server control functions rely on Windows Networking Services to be operable on both
the server and the client. These functions terminate with an error message if Windows Networking is not
operable.

Authentication is performed by standard Windows mechanisms. In order to execute one of the functions,
the interactively logged on user must be able to log on to the server and be allowed to perform the
requested tasks within the operating system.

Usually administrator or power user privileges are required at the target machine. The user rights required
can not be changed with standard Windows tools.

Message Server Monitoring
This group of functions allows to restart channels, reload nodes, or reset disks of a message server.
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The message server performs authentication in this case. For this purpose the user ID and password
have to be specified at the Add Message Server… window.

The specified user ID and password must belong to a valid user account previously configured using for
example TCfW.

Basic Monitoring
This group of functions can be used by system administrators to control single processes at a generic
server.

The supervisor service of the server being connected to performs authentication. For this purpose a
password has to be entered with the Add Server…window. The supervisor service checks the password
and grants access if it is correct.

Unlike the other authentication mechanisms only a password is required to access the server.

This security check can be disabled if access check as not required.

Authentication Features:
• Per-Server authentication
• No Windows Networking required at the client
• All-or-None authentication
• Remote lock-out

Per-Server Authentication
For every single generic server added to the list of monitored servers a separate password must be
specified. The password is used for authentication only with the single server this information was
specified for. The access check at the server can be disabled if necessary.

This feature allows assigning responsibility for specific servers to certain administrators only.

In newer Windows Server operating systems, only an administrator has the right to start and stop
Windows services. Either start TCMON with “Run as administrator” or check the following flag in the
Compatibility tab of the TCMON shortcut.

No Windows Networking
For basic monitoring (viewing the server and controlling processes) or message server monitoring,
TCMON uses none of the standard mechanisms of Windows to remotely login to a server. Therefore,
Windows Networking services are not required between the server and the client.
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Windows Networking services can be disabled at the client side, using only bare TCP/IP as transport to
the server.

However, for enhanced service control (start/stop the supervisor service, or reboot Windows) Windows
Networking services must be enabled. If Named Pipes is the preferred transport between TCMON and the
server, Windows Networking services must be enabled as well.

Authentication
Non-administrator users can start and stop processes. Administrators can start and stop services as well
as processes.

Under Windows Server 2008 and later, you may start TCMON with “Run as administrator” or check the
following flag in the Compatibility tab of the TCMON shortcut.

Note In compliance to TCMON policy, TCMON accepts the server and adds it to the list of monitored
servers even if the password is wrong or any other error prevents a proper connection.

In this case only the status text of the server in the tree view displays the error.

Remote Lock-Out
If the password at a specific server is changed from one TCMON, any other TCMONs currently monitoring
the same server are immediately locked out and are no longer able to view the server.

In this case, all TCMONs using the old password have to relog in.
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KCS Monitor Add-on

The configuration mode enables the TCMON with the help of Add-ons to configure and to create
instances of the locally installed KCS server applications.

Each KCS application comes optionally with an own Add-on, which handles the whole user interaction and
change process.

The Add-ons are simple DLLs, which are called by TCMON to accomplish this job.

Under Windows Server 2008 and later, the add-on can only be used if TCMON has been started with
administrator privileges (“run as administrator”).

A new registry key allows to enable/disable the configuration mode
HKEY_LOCAL_MACHINE\SOFTWARE\TOPCALL\TCMON

Name Default Description

EnableConfigurationMode 0 (REG_DWORD) Enables or disables the configuration mode. If disabled no Add-
ons are loaded and the menu entries for the configuration are
always disabled.

A new registry key located at each install application identifies the installed Add-ons:
HKEY_LOCAL_MACHINE\SOFTWARE\TOPCALL\<APPLICATIONNAME>

Name Description

AddOn Name and location of the Add-on. Note: Normally the Add-on will be installed in the C:\TOPCALL\SHARED
\ADDONS directory

That means the new features are only offered for a specific instance if the TCMON finds this registry key
at the described place.
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Chapter 5

Menus

This section describes the TCMON menu items.

File Menu
This section describes the File menu items.

Add Server …
Toolbar: 

Adds a generic KCS server to the list of servers. Selecting this command opens a window requesting the
Windows network name or the IP address of a KCS server. TCMON supports either the Windows Named
Pipes mechanism or TCP/IP to query the server.

Named Pipes requires the NetBIOS protocol to be available (based on any other protocol TCP/IP, IPX,
or NetBEUI) and, additionally, the basic Windows Networking services such as Server Service and
Workstation Service.

TCP/IP is based on Windows Sockets and does not require any Windows Network specific service
(Browser, Workstation Service, Server Service, …) for basic monitoring functions. To Start/Stop the
Supervisor Service or the restart the entire server, Windows Networking may still be required.

The option TCP/IP Connection must be enabled to use TC/IP instead of Named Pipes.
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The button Browse… displays a window with a list of PCs within the network. This list is provided by the
browser service of Windows. To be able to see the PCs in the list, the Windows network must be properly
installed and enabled. Under Windows Server 2008 and later, there is no Browse button; type the server
name directly.

Select a name from the given list of servers or enter the computer name directly.

Note The Help button does not work.

If the security check at the server is enabled a valid password has to be specified in order to be allowed to
access the server.

By default security check is disabled after installation. It can be enabled by simply entering a new
password with TCMON. It can again be disabled by specifying an empty password.

To change the password, press the button Change >>.

23



Kofax Communication Server Monitor User Manual

The password can have a maximum of 16 alphanumerical characters (characters like asterisk,
parentheses, punctuation marks, … are not allowed). Alphabetical characters are case sensitive.

On pressing OK, TCMON assumes the user wants to change the password if the fields New and Retype
are visible even if these fields are empty! Click the button Change << to hide these fields if you do not
want to change the password.

After adding the new server it may take a while for TCMON to connect to the server and to query the
status of the processes. It is possible to continue working while TCMON queries the server because the
status updates are done in a separate thread in the background.

Add Message Server …
Toolbar: 

Adds a KCS message server (TCOSS) to the list of servers. Selecting this command opens a window
requesting the server ID, server path, user ID and password.
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These parameters are similar to the login parameters of TCfW. TCMON acts as normal client application
for the message server. For this purpose, it uses the new TFC standard API to connect to the server.

It is recommended to specify a fully qualified path to the server (link type, name or IP address, alternate
paths).

After adding the new server it may take a while for TCMON to connect to the server and to query the
status of the processes. It is possible to continue working while TCMON queries the server because the
status updates are done in a separate thread in the background.

Remove Server
Toolbar: 

Disconnects and removes the currently selected server. A valid server must be selected and highlighted in
the tree view. If the selected item is no server, e.g. a process or node, a message box appears. TCMON
does not remove the parent server for this item.

In most cases, the server is not immediately removed. Instead TCMON silently accepts the request to
remove the server and tries to properly close all connections in the background first. This may take some
time while the server is still visible. It is possible to continue working because all actions to close the active
connections and to remove the server ore done in a separate thread in the background.

Most Recently Used
There are up to eight entries in the list of most recently used servers. Message servers in the list are
distinguished by the “(Msg)” appendix of the name. An appendix of “(TCP/IP)” indicates a TCP/IP
connection to a generic server.

Selecting a generic KCS server immediately adds that server to the tree view.

Selecting a message server brings up a message box with all previously set parameters except the
password. The password must be re-entered.

All parameters but the server name can be modified to adapt to changed conditions for logging in.

The MRU list is stored permanently within the registry at program exit. The MRU list is global to all users
of one Windows PC.
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Exit
Terminates TCMON.

Edit
Note These commands do not replace the setup procedure. Only the settings are copied, not the
necessary files.

Copy
Copy the selected node to the clipboard.

This command is only available for configurable nodes

Paste
Pastes the content of the clipboard at the insertion point. The KCS Monitor Add-on responsible for the
pasting displays a “wizard” to ask the user about the mandatory changes.

Delete
Removes the selected node without placing it to clipboard.

This command is only available for configurable nodes.

Note This command deletes “only” the local settings (registry keys, configuration files entries etc.).
Neither the files nor the KCS or Mail dependencies are removed.

Tools Menu
This section describes the Tools menu.

Supervisor
This section describes the Supervisor menu.

Start
Toolbar: 

Starts a supervisor service currently being stopped. A stopped supervisor service is indicated by a generic
KCS server item with a grey triangle.
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To access the service, select the item of a generic KCS server. The server’s item actually represents the
supervisor service.

An error message box appears if the selected item is no valid server or no valid type of server.

If a valid server is selected, a request is sent to the target server’s service control manager to start the
service. Errors reported by the SCM appear immediately. Errors within the supervisor service or one of its
processes become visible with the background status updates.

Important The SCM relies on the Windows network services for remote access. If Windows Networking
is not properly installed or disabled on either the local or target machine, the Start Supervisor command
will terminate with an error.

To maintain the supervisor service administrator rights on the target machine are required.

Under Windows Server 2008 and later, only an administrator has the right to start and stop Windows
services. Either start TCMON with “Run as administrator” or check the following flag in the Compatibility
tab of the TCMON shortcut:

However, even a non-administrator may start and stop processes via TCMON.

Stop
Toolbar: 

Stops a supervisor service currently being started. A started supervisor service is indicated by a generic
KCS server item with a red triangle.

To access the service, select the item of a generic KCS server. The server’s item actually represents the
supervisor service.

An error message box appears if the selected item is no valid server or no valid type of server.

If a valid server is selected, a message box appears to conform stopping the service. After confirmation,
a request is sent to the target server’s service control manager to stop the service. Errors reported by the
SCM appear immediately. Errors within the supervisor service or one of its processes become visible with
the background status updates.

Stopping the supervisor service causes all of its processes to be stopped as well.

Important The SCM relies on the Windows network services for remote access. If Windows Networking
is not properly installed or disabled on either the local or target machine, the Stop Supervisor command
will terminate with an error.

To maintain the supervisor service administrator rights on the target machine are required.
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Under Windows Server 2008 and later, only an administrator has the right to start and stop Windows
services. Either start TCMON with “Run as administrator” or check the following flag in the Compatibility
tab of the TCMON shortcut:

However, even a non-administrator may start and stop processes via TCMON.

Reload Supervisor Process List
Toolbar: 

Reloads the process list of the selected supervisor from the registry. With this button you could add and
remove processes to a supervisor without stopping this supervisor.

Note You could only remove processes that are not running.

Process
This section describes the Process menu.

Start
Toolbar: 

Starts the currently selected process. If no valid process is selected an error message box appears.

If a valid process is selected, TCMON sends a request to the controlling supervisor service to stop the
process. Errors reported by the service appear immediately.

The process’ actual status becomes visible with the background status updates.

Stop
Toolbar: 

Stops the currently selected process. If no valid process is selected an error message box appears.

If a valid process is selected, a message box appears to confirm stopping the process. After confirmation,
TCMON sends a request to the controlling supervisor service to stop the process. Errors reported by the
service appear immediately.

The process’ actual status becomes visible with the background status updates.
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Kill
If the button  is clicked a request for a hard shutdown is sent to the process. If the button  is

clicked a request for a graceful shutdown is sent to the process.

Note Graceful shutdown and hard shutdown is currently supported only for the process TCECP.

Reload Configuration
If the button  is clicked a request to reload the configuration is sent to the process.

Note Reload configuration is currently supported only for the process TCECP.

Properties
This menu entry allows changing the configuration of the nodes via an installed KCS Monitor Add-on. All
configuration changes are made permanently only after the user actively accepts them. This prevents
unwanted changes.

Reset/Reboot
This section describes the Reset/Reboot menu.

Server
Toolbar: 

This menu option allows to remotely shut down and restart Windows on the target server. A valid generic
KCS server must be selected for this command to be executed.

A message box appears to confirm shutting down the target system.

Initiating a shutdown causes the target system to display a message box for 30 seconds. After this delay,
all applications are automatically closed and Windows is restarted.

Important This command relies on the Windows network services for remote access. If Windows
Networking is not properly installed or disabled on either the local or target machine, this command will
terminate with an error.

To reboot a server administrator rights on the target machine are required. Under Windows 2008 and
later, only an administrator has the right to reset/reboot a server. Either start TCMON with “Run as
administrator” or check the following flag in the Compatibility tab of the TCMON shortcut.
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Node
Toolbar: 

This menu option forces a reboot of the selected node on a message server. With the selected node all of
its sub-nodes are rebooted as well.

Rebooting a node means to execute a hardware reset for this node, to reboot its operating system and to
restart all of its channels.

An error message box appears if no node is selected.

For a valid node a message box appears to confirm rebooting. After confirmation, a request is sent to the
message server to reboot the selected node. Errors reported by the message server appear immediately.
Status changes for the node become visible with the background updates.

Channel
Toolbar: 

This menu option forces the message server to reload the configuration for the selected channel. An error
message box appears if no channel is selected.

For a valid channel a message box appears to confirm reloading configuration. After confirmation, a
request is sent to the message server to reload the configuration of the selected channel. Errors reported
by the message server appear immediately. Status changes for the channel become visible with the
background updates.

Time to reload the configuration of a channel may be shorter than TCMON’s interval for status updates.
Status changes may not be seen with TCMON in this case.

This command can not be executed on Client/Server channels. Due to a current restriction of TCOSS,
only channels of type UAS, UTX and UMM can be fully reloaded with this command. For all other
channels an additional node reboot is required (see 3.2.3.2). No error message will be displayed if the
node has to be rebooted.

Disk
Toolbar: 

This menu option forces resynchronization of desynchronized hard disks in a tandem system. If both disks
of a tandem system have the status “Not Mirrored”, the system is not able to automatically detect the disk
with the most recent (or most important) data. To resynchronize the system one disk must be cleared
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manually using this command. This menu command declares the selected hard disk as outdated and
initiates updating it. The cleared disk has the status “Updating” while re-synchronization is in progress.

A message box appears if no disk is selected. For valid disks a message box appears to confirm clearing.
After confirmation, a request is sent to the message server to clear the selected disk. Errors reported by
the message server appear immediately. Status changes for the disk become visible with the background
updates.

If the system is not in the desynchronized state, the message server silently ignores the request.

View Menu
This section describes the View menu.

Expand
Toolbar: 

Expand the selected item (if it possible).

Collapse
Toolbar: 

Collapse the selected item (if it possible).

Expand All
Toolbar: 

Expand all items in the display.

Collapse All
Toolbar: 

Collapse all items in the display.

Expand All on Loading
Enable or disable, that all items will be expanded on loading a server.

The value is persistent.
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Toolbar
Enables or disables displaying the toolbar.

Status Bar
Enables or disables displaying the status bar.

Help Menu
This section describes the Help menu.

About …
Toolbar: 

Displays the About-Box with information about TCMON.
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Hints

This section describes hints for using TCMON.

Automatically Adding Servers at Startup
TCMON supports adding virtually any number of servers automatically at startup. The servers to be added
have to be specified as command line parameters when TCMON is started.
TCMON32.EXE [<Server1>] [<Server2>] …

If only a simple name such as DEMOTC is specified for <Server>, TCMON considers this a Windows
network name for a generic KCS server.

To specify a TCP/IP connection, prefix the name or IP address with the string “TCP/”. It is possible to
additionally specify the password at the command line. Syntax:
[TCP/]<ServerName>[/<Password>]

The server name is mandatory. The TCP switch and the password are optional and must be separated by
the slash (“/”) character from the server name. If the password is not specified, TCMON displays a window
requesting for it.

If you do not use a password for your server you have to append a "/" to the server name. By doing so,
the window requesting the password will not be displayed. This is especially useful, when you load several
servers during start up of TCMON, e.g. using following command line
TCMON32.EXE TCOSSSERVER/ LINKSERVER1/ TCOSSSRV#TCP/IP,TCOSSSRV#TCTECH#password

For TCMON to properly recognize <Server> as message server, the command line parameter must be
specified with following syntax:
<ServerName>#<ServerPath>[#<UserID>[#<Password>]]

The server name and the server path (TCTI path syntax) are mandatory. The user ID and password are
optional and may be left out at the command line. If either password or both password and user ID are not
specified at the command line, TCMON brings up a window to enter the missing parameters needed to
login.

Servers are added in the order specified at the command line. No sorting or rearrangement is done.

Examples:
TCMON32 TCLINK

Pops up a window to enter the password for the generic server.
TCMON32 TCLINK/Passwd DEMOTC#TCP/IP,193.81.166.100#TCTECH
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First adds TCLINK as generic server and then pops up a window to enter the missing password for the
message server DEMOTC to be added next. If you click Cancel, TCMON does not add the specified
server.
TCMON32 TCLINK DEMOTC#TCP/IP,193.81.166.100#TCTECH#tctech

First pops up a dialog for the password of TCLINK, then silently adds the message server DEMOTC.
TCMON32 TCP/TCLINK/Passwd

Uses TCP/IP instead of Named Pipes to connect to the server.

Context Menus and Message Server
Context menus are not available for message server.

Keyboard-Only Operation
In case there is not mouse installed or the mouse is not working properly TCMON can be operated
using the keyboard only. To get into the menu simply press the <ALT> key together with the underlined
character of the desired menu option, or press the <ALT> key and select the option using the cursor keys.
By now, there are no shortcuts or function keys to execute a menu option.

To select an item from the tree view hit <TAB> or <F6> to move the input focus to server hierarchy tree.

To select the context menu press the <Menu> key, or <SHIFT>-<F10> if you are working with an older
keyboard.
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Requirements

This section describes the requirements for using TCMON.

Operating Systems
Any currently supported Operating System. For more details about supported operating systems, refer to
Environment Guide - Platform System Manual.

On Windows Server 2008, apply this hotfix to prevent problems with named pipes protocol: http://
support.microsoft.com/kb/974178/.

User Rights
Windows Administrator or Power User rights on the target server to reboot Windows or to maintain the
supervisor service. It is not possible to change the rights to maintain the supervisor service by means
of standard Windows tools. The privilege to reboot Windows can be granted or denied using the menu
Policies/User Rights of the User Manager.

Any user account with TECH rights for TCOSS to maintain the message server (channels, nodes, disks).
Note: Current releases accept any type of account.

Network Protocols
This section describes the network protocols used by TCMON.

Generic KCS Server
TCMON uses the Windows Named Pipes method or TCP/IP to communicate with the supervisor service.

For Named Pipes, NetBIOS frames (based on any of the other protocols TCP/IP, IPX, NetBEUI) have to
be allowed and enabled on the network.

In addition, windows networking (server service, workstation service, …) has to be enabled.

This applies to both the local and the target machine.

For TCP/IP protocol basic monitoring does not require Windows Network services. Thus, services such as
browser, workstation server, … need not be enabled for basic monitoring functions.
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The commands Start/Stop Supervisor and Restart Server do not communicate with the supervisor service.
Instead, they access Windows services, which still require Windows Networking to be available on both
the local and target machine.

Usually these commands are required only when performing release updates in which case access to the
hard disks of the server is required as well.

Note If the Windows Network is not enabled, TCMON may improperly report a server as “power off”.
This may happen if the supervisor service is not started and TCMON gets no connection to it. In this
case TCMON tries to query the status of TCSRV via the service control manager, which fails if the
windows network services are not running properly.

Message Server
As all other clients (e.g. TCfW) TCMON uses TCTI as base transport to connect to the message server.
All restrictions and requirements that apply to TCTI and client applications such as TCfW apply to TCMON
as well.

By default TCMON uses RPC as transport type. It is recommended to specify a full-qualified TCTI path
(Linktype and network name or IP address, with possible alternate paths) for a message server.

For native transport, corresponding entries must be added to the registry.

Registry
The main key for TCMON is HKEY_LOCAL_MACHINE\Software\TOPCALL\TCMON.

The registry DWORD value EnableConfigurationMode is created during the setup procedure.

The registry DWORD value ExpandAllAtStartup stores the “Expand all on loading” value.

The registry REG_SZ value Font can be created manually, in order to change the font for the process
status tree view. The default font (Tahoma) is capable of displaying many character sets. If some status
lines are not displayed correctly, it is recommended to use the font Arial Unicode MS (installed with
Microsoft Office).

Additional sub-keys can be created for the modules TCSI and TCTI to change any of the default
parameters. Refer to the corresponding manuals.

TCMON automatically creates a registry key HKEY_CURRENT_USER\Software\TOPCALL\TCMON
\RecentFileList to store the MRU list at exit.

Modules
Unless otherwise noted, the module versions can be higher or equal.

TFC32.DLL 1.02.02

TCSI32.DLL 2.20.00
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TCTI32.DLL 2.10.01

TCLIB32.DLL 7.24.12

TCRPC32.DLL 7.09.08

Microsoft redistributables:

MFC42U.DLL 6.06.8064

MSVCRT.DLL 4.20.6201

KCS Server
TCP/IP connection:

To use the TCP/IP protocol to connect to the generic KCS server following modules are required on this
server:

TCSRV.EXE 7.13.01 or higher

TCRPC32.DLL 7.09.08 or higher

TCP/IP protocol must be enabled on the server. This is done either automatically during setup or manually
by changing the registry value:

HKEY_LOCAL_MACHINE\Software\TOPCALL\Boot

TCRPCServerMode = DWORD = 1

Values 1 TCP/IP

3 Named Pipes (default)

The values are mutually exclusive. Only one of both protocol types can be active at the same time.

Named Pipes connection:

The named pipes connection type does not require any special module versions at the server. Using
Named Pipes protocol TCMON is compatible to all previous versions of Model 1xx or 2xx.

Reload configuration, graceful shutdown and hard shutdown:

The commands require that the registry value RPCInterfaceVersion is set to 2 for the process on the
server, otherwise the command will be ignored.

HKLM\SOFTWARE\TOPCALL\ProcessID\ RPCInterfaceVersion = DWORD = 2

Note Currently only supported by the process TCECP.exe (Version 2.08.00 or higher).
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